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Chapter 1  

Introduction 

The following release notes state known problems and last minute changes to Open Text eDOCS 
DM Version 6.0.5 Preview. Open Text recommends that you read these Release Notes in conjunction 
with the documentation included with the software package.  If any conflicts exist, the Release Notes 
supersede the other documentation. 

Check the Open Text Knowledge Center at (https://knowledge.opentext.com/) for any patches or 
documentation updates that may have been posted after the initial release of this version of Open 
Text eDOCS DM. 

1.1 Contact Information 

Open Text Corporation 

275 Frank Tompa Drive, Waterloo, Ontario, Canada, N2L 0A1 

Tel: +1-519-888-7111  
Toll Free Canada/USA: 1-800-499-6544 International: +800-4996-5440  
Fax: +1-519-888-0677   
E-mail: support@opentext.com  
FTP: ftp://ftp.opentext.com  
For more information, visit http://www.opentext.com 
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Chapter 2  

About Open Text eDOCS DM 6.0.5 

2.1 General Information 
 

The DM 6.0.x service and maintenance releases are cumulative. That is, a later 

service or maintenance release will contain everything that an earlier service or 

maintenance release contained, plus any new modifications.   A list of Fixed Issues in con-

tained in this release can be found here. 

 
For information about issues fixed in Releases 6.0.1, 6.0.2, 

6.0.3, and 6.0.4, see the release notes for those releases: 

 

DM and RM 6.0.1 Release Notes 

DM and RM 6.0.2 Release Notes 

DM and RM 6.0.3 Release Notes 

DM and RM 6.0.4 Release Notes 

DM and RM 6.0.4 CU1 Release Notes 

DM and RM 6.0.4 CU2 Release Notes 

DM and RM 6.0.4 CU3 Release Notes 

DM and RM 6.0.4 CU4 Release Notes 

DM and RM 6.0.4 CU5 Release Notes 

DM and RM 6.0.5 CU6 Release Notes 

 

2.2 Documentation 

The documentation and help files in DM 6.0.5 are those delivered with DM 6.0.1. Consult these for 

the core documentation set; however, you must also read the following documents to obtain new or 

corrected documentation: 
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New Documentation—The Open Text - Using  eDOCS DM 6.0.5 Software document contains 

specific information related to this release, including using Microsoft Office 2007, Windows Vista, 

Dynamic Views, DM Extension for Lotus Notes, updates to Dynamic Views documentation, and 

how to setup Project 2007 with Interceptor.  This new information is not located within the original 

core documentation set. 

New Documentation and Updates—The DM/RM 6.x Documentation Updates document contains 

new and updated documentation since the original release of DM 6.0.1, including information as a 

result of service releases and maintenance releases. This document also contains clarifications to 

existing documentation. 

Windows Help (WinHelp) Not Included in Windows Vista 

The Help files delivered with DM 6.0.5 were created in Windows Help (WinHelp) format. The 

Windows Help format is not supported, nor included, with Windows Vista operating systems. You 

can download the WinHelp.exe application and use it to view DM Help files on Windows Vista 

operating systems. Download the Winhelp.exe application from Microsoft’s web site at the 

following location: http://go.microsoft.com/fwlink/?LinkID=82148. However, the following known 

issue has been reported by Microsoft. When you open a Help topic (by pressing F1 or by selecting 

Help>Contents and Index), the following error message appears: “There was a problem running 

the macro. (1037).” After this initial error, you can continue using the Help files. For more 

information and workarounds to this issue, consult Microsoft’s Article ID 917607 at the following 

location: http://support.microsoft.com/kb/917607. 

NOTE: The Help files do not contain any new information for DM 6.0.5.  You must consult the 

Open Text - Using eDOCS DM 6.0.5 Software and DM/RM 6.x Documentation Updates documents 

for all new information pertaining to this release. 

 

2.3 New Features 

• DM-14425: Support for Microsoft Vista operating systems 

• DM-11425: Support for Microsoft Office 2007 COM integration 

• DM-10286: Support for Lotus Notes 8 

• DM-10581: Support for Adobe Acrobat Reader 8 
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• DM-6294: Support for Internet Explorer 7 

• DM-6582: Updated Content Drive 

• DM-581: Rename the "new document template" Action in the DM Webtop to “New 
Document from Template” 

• DM-12556: Ability to Limit Search Results in the DM Webtop per user 

• DM-12596: Ability to use a personalized home page within Lotus Notes 

• DM-14178: Ability to allow both mixed and Windows authentication to the SQL Server via a 
pcdocs.ini setting 

• DM-11760: Ability to Filter Event Notifications from Enterprise Workflow on the DM Server 

• DM-11070: Increase the limit of imaging documents that can be opened at one time 

• DM-10945: Display the message "The last page of a document cannot be deleted” when 
attempting to remove the last page of an imaging multi-page document. 

• DM-10112: Ability to prevent the overwriting of log files  

• DM-10023: Ability to save the full email address on the profile form 

• DM-9966: Ability to hide the default Quick Searches  

• DM-9964: Allow the user operating system’s settings to control the font size in Explorer and 
Outlook Extensions 

• DM-9579: Support for EMC Centera Read-only Server 

• DM-9063: Ability to Suppress the “Press OK to retrieve a read-only copy of the document” 
Message 

• DM-8932: Removal of the NFS path in the Microsoft Office status bar 
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• DM-8556: Ability to insert objects into Word documents when disable native dialogs is 
enabled 

• DM-8385: Indicate if an incorrect entry is made into a profile form in DM Webtop  

• DM-8180: Ability to resize the Access Control List (ACL) 

• DM-7959: Allow additional read-only copies of a document to be opened when a read-only 
copy is already open 

• DM-6002: Ability to control if the status of “Managed/Unmanaged” appears in the 
Microsoft Excel toolbar
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Chapter 3  

Supported Environments 

The following tables list the supported environments in DM 6.0.5. 

3.1 Server Machines 

3.1.1 DM Server 
Processor Dual Pentium 4,  

1.9 GHz or better 

Memory 2 GB or greater (1 GM minimum) 

Operating System Microsoft Windows 2003 Server SP2 
Microsoft Windows 2000 Server 

Databases Microsoft SQL Server 2000 and 2005 
Oracle 10g Release 2 and Oracle 11 

 

NOTES: For optimal SQL server performance, we recommend a dedicated server-class machine 
with a minimum of 1 GB RAM. 

The system requirements for DM Workflow, RM, and Collaboration DM Server Integration are 
the same as for DM. The DM Server machine requires approximately 60 MB of disk space for 
Collaboration DM Server Integration. 
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3.1.2 Document Server 
Operating System Novell Netware 6.5 

Microsoft Windows 2003 Server 
Microsoft Windows 2000 Server 
EMC Centera 

3.1.3 DM Web Server 
Processor Dual Pentium 4,  

1.9 GHz or better 

These processor requirements are for 
dedicated DM Server machines. If SQL 
engines and/or DM Web Server are 
installed on the same machine, 
additional processing power and 
memory will be required. 

Memory 2 GB or greater (1 GM minimum) 

Operating System Microsoft Windows 2003 Server 
Microsoft Windows 2000 Server 

Web Server Internet Information Server (IIS) 5.0 or 
6.0 

Client Internet Explorer 6.0 and 7.0 

NOTE: The system requirements for DM Workflow Web Server are the same as for DM Web 
Server. For the Internet Imaging Document  Server (IIDS) on the DM Web Server, we 
recommend a dedicated partition of 10 GB for the image cache. 

3.2 User Workstations 
Processor Pentium III 600 or better (recommended) 

Pentium III 500 (minimum) 

Memory 512 MB or greater (recommended) 

Operating System Microsoft Windows XP (SP2, SP3)  

Microsoft Vista (SP1) 

Citrix Presentation Server 4.5 

VMWare ESX Server 

Web Browser Microsoft Internet Explorer 6.0 and 7.0 

NOTES:  

• If DM Imaging is installed on user workstations, we recommend at least 128 MB of 
RAM and 500 MB of free disk space if users are viewing large images. 

• DM Extension for AutoCAD requires Autodesk AutoCAD 2007 or 2008.  We 
recommend a 1024 x 768 VGA video display. Minimum of 800 x 600.  

• The system requirements for DM Workflow Extensions and DM Extensions for 
AutoCAD are the same as for DM client workstations. 
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3.3 Supported Applications 

 

3.3.1 Integrated Applications 

The following table lists the applications supported in DM 6.0.5: 

Adobe Acrobat 7.0 and 8.0 

AutoCAD 2007 and 2008 

Corel Presentations 12.0 and X3 

Corel Quattro Pro 12.0 and X3 

Corel WordPerfect 12.0 and X3 

Lotus 1-2-3 9.7 and Millennium Edition 9.8 

Lotus Word Pro 9.7 and Millennium Edition 9.8 

Microsoft Word 2003 and 2007 

Microsoft Excel 2003 and 2007 

Microsoft Visio 2003 and 2007 

Microsoft PowerPoint 2003 and 2007 

Microsoft Project 2003 and 2007 

Workshare DeltaView 3 (3.8680.0190) and 4.5 SR1 point release 2 (4.5.8680.116) 

3.3.2 E-mail Applications 

The following e-mail applications are supported in DM 6.0.5: 

Novell GroupWise 6.5 and 7.0 

Lotus Notes 7.x  and 8.0 

Microsoft Outlook 2003 and 2007 

 





 

Open Text eDOCS DM   Version 6.0.5    Release Notes 17 
  

 
 

Chapter 4  

Installation Notes 

Before installing DM 6.0.5, review the Configuration Notes and the Fixed Issues sections for 
information that may be applicable to your DM implementation. 

When you download the DM 6.0.5 release, it is extracted by default to C:\Program 
Files\Hummingbird\Enterprise 2005 6.0.5\Image 200 You can change the installation path, if you 
want. When the download is finished, the Hummingbird Service Release Browser launches. You can 
download Release 6.0.5 for each server that you update, or you can download the service release set 
to a shared network location and update your servers from there. If you are running from a network 
location, double-click \Enterprise 2005 6.0.5\ setup.exe to launch the service release browser. 

The 6.0.5 updates to the DM API are installed with the DM Server and DM Extensions updates for 
Release 6.0.5. 

When running AutoUpdate with DM 6.0.5, the Add/Modify/Repair dialog will be 
presented to the user.  A fix was placed in 6.0.5 which will take effect in DM 6.0.5 CU1. 

 

.NET Framework 2.0 

The .NET Framework 2.0 is a prerequisite for all products and is included with the DM 6.0.5 

release. To install, please download the Framework from the Microsoft Download Center. 

You must install .NET Framework 2.0 on both the client and server machines. 

Oracle Hybrid Searching 
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Oracle is supported in hybrid searching. The hybrid search enhancement changes the way in which 

the INDEX table uses metadata when performing a hybrid search, which is a search that contains 

both profile and content search criteria. 

For complete instructions on using hybrid searching, consult the "Improved Performance for Hybrid 

Searches" section in the DM/RM 6.x Documentation Updates document. 

Support for Microsoft Office XP 

Although Microsoft Office XP is not listed as a supported application for DM 6.0.5, we have 

performed minimal testing with Microsoft Office XP and determined that integration is possible. 

Open Text encourages customers to upgrade to Microsoft Office 2003 or Microsoft Office 2007 

before deploying DM 6.0.5; however, if that is not possible, we will continue to support customers 

using DM 6.0.5 with Microsoft Office XP. 

Consult the Open Text - Using  eDOCS DM 6.0.5  Software document for the “Supported 

Applications and Platforms in DM 6.0.5” chapter. 

Support for Microsoft SQL Server 2005 

Support for Microsoft SQL Server 2005 is provided in native  mode. 

Update Deployment Packages Created Prior to DM 605 

Deployment Packages that were created prior to DM 6.0.5 need to be updated. Edit your existing 

deployment packages, re-enter your administration credentials, reselect the correct components, and 

execute a Save before using the package.  After you install DM 6.0.5, you should run the 

Deployment Package Wizard and resave all deployment packages that use the “Run as 

Administrator” option. 

To re-save a deployment package: 

Click Stat>Programs>Hummingbird>DM Extensions Server Setup>Deployment 
Package Wizard. 

Select a deployment package that has the Run as Administrator option enabled, which is 

displayed in the Details box. 
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Click Edit to edit the deployment package. 

In the Location Information dialog box, click Next. 

In the User Information dialog box, type the administrator credentials to be used by the 

deployment package, and then click Next. 

Continue clicking Next on all subsequent dialog boxes, and then click Save. 

Repeat the above steps for all deployment packages using the Run as Administrator option, and 

then exit the wizard. 

Upgrading or Changing Integration Methods 

When you upgrade or change your integration method (ODMA, COM, Passive, Active, or 

Interceptor) for an application, some menu items might be unavailable, appear twice, or do not 

work as expected. This is working as designed to prevent other potential integration issues, such 

as performance issues, conflicts with third-party macros, and saving and read-only issues with the 

normal.dot file in Microsoft Word. You can resolve this issue by resetting the toolbars. 

To resolve the menu issue: 

Start the application that has unavailable, duplicate, or non-functioning menu options. 

Select Tools>Customize. 

In the Toolbars tab, select Standard, and then click Reset. 

Select Menu Bar, and then click Reset. 

In Microsoft Word, click OK when you are prompted to reset changes in the normal.dot file. 

NOTE: Customizations to the toolbar will be lost by resetting the toolbar. 

User Account Control (UAC) Setting in Windows Vista 
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The User Account Control (UAC) setting in Windows Vista operating systems is enabled by default. 

The following issues occur with this setting enabled: 

• Installing DM Extensions from DM Webtop. 

• Starting DM Extensions after starting the Client Deployment Utility (CDU). 

• Adding a DM server when you log on to DM Extensions. 

For more information about the UAC setting, please consult the Microsoft support site at 

http://support.microsoft.com. 

Windows Vista Firewall 

When using the Windows Vista Firewall, the user may be presented with a dialog to unblock DM-

related items the first time they are run such as papihost.exe and any Office Active COM integrated 

applications.  DM-14359. 

Visual C++ 2005 SP1 

The Visual C++ 2005 SP1 redistributables are a prerequisite to DM Extensions, DM Server, and all 

server-side products that require the DM API. For server-side patch installations, the DM 

administrator should be prompted to install this redistributable. 

For DM Extensions, the user will be prompted only for interactive installations. This redistributable 

will not be removed when DM is uninstalled from the machine. 

 

4.1 DM Server 

4.1.1 Pre-installation 

DM Server 6.0.1 must be installed before Release 6.0.5 can be applied. The Release 6.0.5 installation 
program validates the licensing to determine which products are installed and installs files that need 
updating.   
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Before installing the DM Server files on a server that is indexing with SearchServer™, stop your 
SearchServer indexes using DM Server Manager. When the installation is finished, restart the 
indexes.  See Section 5.4 for additional information about creating and deploying indexes with DM 
6.0.5. 

If DM Web Server is installed on the DM Server machine, it must be stopped to release connectivity 
with the DM API. Shut down the IIS Admin Service in Control Panel>Services. When the installation 
is finished, restart the IIS Admin Service and all appropriate Web services. 

How to Install 

To install Release 6.0.5 on the DM Server being updated, from the service release browser, 
click Install Products>DM Server. 

The DM Server installation shuts down the DM Server service, installs the Release 6.0.5 files, 
and restarts DM Server. At the end of the DM Server installation you may receive a Reboot 
Required notice. Reboot the DM Server to complete the installation. If you cannot connect to 
user workstations after the Release is installed, verify that the Server State in DM Server 
Manager is Started. 

4.1.2 After Installation 

DM 6.0.5 requires that you update your database.  Be sure to run Library Generator against 
your database after the installation of DM 6.0.5. 

 

To modify or repair your DM Server installation at a later time: 

1. Uninstall DM Server from Control Panel>Add or Remove Programs. 

2. Using the DM 6.0.1 installation media, perform a Modify or Repair. 

3. Reinstall DM Server 6.0.5. 

4.2 DM Web Server 

4.2.1 Pre-installation 

DM Web Server 6.0.1 must be installed before Release 6.0.5 can be applied. The Release 6.0.5 
installation program validates the licensing to determine which products are installed and installs 
files that need updating. If you have multiple Web Server instances installed for multilingual 
support, the 6.0.5 installation program updates all instances. 

How to Install 

On the DM Web Server being updated, from the service release browser, click Install Products>DM 
Web Server. 
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4.2.2 After Installation 

To update DM Extensions, run DM Extensions Server Setup after updating DM Web Server. 

If you have custom directories for your users or groups, copy the appropriate files from the 
\Cyberdocs\Backup directory to your custom directories after the release has been installed. 

To modify or repair your DM Web Server 6.0.5 installation at a later time: 

1. Uninstall DM Web Server 6.0.5 from Control Panel>Add or Remove Programs. 

2. Using the DM 6.0.1 installation media, perform a Modify or Repair. 

3. Reinstall DM Web Server 6.0.5. 

4.3 DM Workflow Server 

4.3.1 Pre-installation 

DM Workflow 6.0.1 must be installed before the service release can be applied. 

How to Install 

1. On the server being updated, from the service release browser, click Install Products>DM 
Workflow Server. 

2. Apply DM Workflow Server updates. 

3. Update the DM Workflow clients. 

4.3.2 After Installation 

If you need to modify or repair your DM Workflow Server installation at a later time: 

1. Uninstall the DM Workflow Server from Control Panel>Add or Remove Programs. 

2. Using the DM 6.0.1 installation media, perform a Modify or Repair. 

3. Reinstall DM Workflow 6.0.5. 

4.4 DM Extensions Server Setup 

4.4.1 Pre-installation 

DM Extensions Server Setup 6.0.1 must be installed before Release 6.0.5 can be applied. 

How to Install 



 

23  Open Text eDOCS DM  6.0.5   Release Notes  

 

 

On the server being updated, from the service release browser, click Install Products>DM 
Extensions Server Setup. 

After the service release for the DM Extensions Server Setup has been installed, users can log on to 
DM Webtop to upgrade DM Extensions on their machines. 
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Chapter 5  

Configuration Notes 

5.1 Library Regeneration 

All libraries should be updated with DM 6.0.5 using the updated Library Generation utility located 
in the \Tools\DM Server directory. Changes that Library Generation will make are: 

Introduced in Version Description of Library Generation Change 

DM 6.0.5 See the Error! Reference source not found. 
section for changes. 

DM 6.0.4 Changes CALC_SECURITY stored procedure 
that is used to obtain security during a search 
against multiple documents. Impacts any search 
that also gets security. Required for all libraries. 

DM 6.0.4 Provides support for Library Generation with 
Oracle 10g. 

DM 6.0.2 Changes filter for lookup _DMFOLDERS to 
ITEM_TYPE=’F’. Valid for customers using the 
Classified module. 

DM 6.0.2 Corrects a script file error when creating triggers 
for the Classification tables. Valid for new 
Government libraries on Oracle. 

If you are using the Classified Security Module, copy the INDUSTRY.INI file to the Program 

Files\Hummingbird\DM Server\Program directory from the Program 
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Files\Hummingbird\Enterprise 2005 6.0.5\Image 200\Tools\DM Server\Enu\program\csm 
directory before running Library Generation. 

5.2 Database Schema Changes 

ACTIVITYLOG Table Addition 
As of DM 6.0.5, the following column was added to the ACTIVITYLOG table: 

CTIME_LP 

This column contains the low order 32 bits of a FILETIME value, and is used by the 

Content Drive implementation to ensure library-level cached information is current. 

Version Introduced: 6.0.5 

Data Type Integer 

Constraints Allow Null 

 

CTIME_HP 

This column contains the high order 32 bits of a FILETIME value, and is used by the 

Content Drive implementation to ensure library-level cached information is current. 

Version Introduced: 6.0.5 

Data Type Integer 

Constraints Allow Null 

 

COMPONENTS Table Addition 
As of DM 6.0.5, the following column was added to the COMPONENTS table: 

REVISION 

This column contains the current revision number of the component file. The value of this 

column is updated when a new file revision is committed. File revisions are committed as 

part of the document unlocking process, which signals the end of a file edit session. 
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Version Introduced: 6.0.5 

Data Type Integer 

Constraints NOT Null 

 

DOCSERVERS Table Change 
As of DM 6.0.5, the length was changed from 64 to 200 in the LOCATION column. 

Following is the new Data Type NVarChar value. 

LOCATION 

Data Type NVarChar(200) 

 

NFS_FILE_LIST Table 
The NFS_FILE_LIST table was introduced in version 6.0.5 of the DM database. This table 

is used to manage file revisions and map users to specific file revisions. The 

NFS_FILE_LIST table is managed completely by the DM/NFS infrastructure. Table rows 

are added and deleted as needed. In an idle system, this table should optimally be empty. 

CLIENT_ID 

A numeric value supplied by the NFS server, which identifies the physical client to which 

the file mapping applies. This value is used to distinguish the possibility of the same DM 

user accessing a specific file from different physical machines. 

Version Introduced: 6.0.5  

Data Type Integer 

Version Introduced:  

DELEGATION_FLAG 

The status of the NFS v4 delegation for the physical file to which the file mapping applies. 

Version Introduced: 6.0.5  
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Data Type Integer 

Version Introduced:  

DOCNUMBER 

A link to the PROFILE table to identify the document number of the item. 

Version Introduced: 6.0.5  

Data Type Integer 

Version Introduced:  

PATH 

The name of the physical file to which the file mapping applies. This is equivalent to the 

COMPONENTS.PATH column; however, it might have a different value, depending on 

the current revision level of the document/version. 

Version Introduced: 6.0.5 

Data Type NVarChar (128) 

Version Introduced:  

REVISION 

The incremental file revision associated with the file mapping. The actual file revision of a 

document or version is maintained in the COMPONENTS table. 

Version Introduced: 6.0.5  

Data Type Integer 

Version Introduced:  

USER_ID 

The numeric ID (PEOPLE.SYSTEM_ID) for the user to which the file mapping applies. 

Version Introduced: 6.0.5  

Data Type Integer 

Version Introduced:  
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VERSION_ID 

A key field used to uniquely identify each version record.  

Version Introduced: 6.0.5  

Data Type Integer 

PROFILE Table Additions 

CTIME_LP 

Contains the low order 32 bits of a FILETIME value.  This column is used by the Content 

Drive implementation to ensure document-level cached information is current. 

Version Introduced: 6.0.5 

Data Type Integer 

Constraints Allow Null 

 

CTIME_HP 

Contains the high order 32 bits of a FILETIME value.  This column is used by the Content 

Drive implementation to ensure document-level cached information is current. 

 

Data Type Integer 

Constraints Allow Null 
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VERSIONS Table Additions 

CACHE_STATUS 

This column is used by the Content Cache implementation to store the current status of 

lazy write upload operations. This column was added to eliminate version level status 

value collisions with RM functionality. 

Data Type Integer 

Constraints Allow Null 

Version Introduced: 6.0.5 

Values 

0 No Activity 

22 Cache upload in progress. 

23 Cache upload failed.  

 

CTIME_LP 

This column contains the low order 32 bits of a FILETIME value. This column is used by 

the Content Drive implementation to ensure version-level cached information is current. 

Data Type Integer 

Constraints Allow Null 

Version Introduced: 6.0.5 

CTIME_HP 

This column contains the high order 32 bits of a FILETIME value. This column is used by 

the Content Drive implementation to ensure version-level cached information is current. 

Data Type Integer 
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Constraints Allow Null 

Version Introduced: 6.0.5 

5.3 Oracle 

To create an Oracle ODBC connection, you must first establish an Oracle Local Net Service Name 
Configuration for the Oracle Server machine. This requires installation of the Oracle client and 
ODBC driver on the DM Server machine. 

1. To install the client and ODBC driver, perform an Administration installation of the Oracle 
Client for 10gR2 or 11g.  

2. Use one of the following ODBC drivers installed with the client software: 

• Oracle 10gR2: Driver 10.0.2.0.1.0 patched to 10.0.2.0.3.0 with ODBC patch #5699495 

• Oracle 11g: Driver 11.1.0.6.0 or later 

5.4 Importing DM e-Clips into Enterprise Webtop 

Perform the following steps to import DM e-Clips into Enterprise Webtop for DM 6.0.5: 

1. Log on to Enterprise Webtop as an administrator. 

2. From Administration, select Import. 

3. Browse for the file DM6eClips.zip (..Program Files\Hummingbird\....\Tools\DM Web 
Server\eClips). 

4. Click OK. 

 

5.5 DM Indexer Considerations 
 

This release contains SearchServer 6.1.0.167. When upgrading from any earlier DM 6.x re-

lease, you must create new indexes of your DM Libraries. We recommend that you config-

ure one indexing server to build your new indexes before deploying DM 6.0.5 to client 

workstations. Alternatively, you can select previous releases of SearchServer indexes for 

client searching while you build the indexes; however, these indexes must be static and 

cannot be updated by SearchServer 6.1.0.167 during the transition. You can also create in-

dexes before rolling out the upgrade to clients. 
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Lotus Notes emails (DXL) are not being indexed.  An error will appear in the indexer 
logfile similar to:  

 

Tue Sep 23 16:41:53 2008: Document 71: [809GD] [Hummingbird][SearchServer]Text reader error : 
hummingbird://docsfusion/profile/DM60503199/DM60503199/71/%VERSION_TO_INDEX: Line 
2 Col 57 'An exception occurred! Type:RuntimeException, Message:Could not open DTD file 
'xmlschemas/domino_7_0_3.dtd'' (DM-14906) 

 

In DM Server Manager on the Search Servers tab the "Size" column is calculated incorrectly in 
DM 6.0.5 because of the changes made in the new version of Search Server. (DM-14797) 
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Chapter 6  

Microsoft Office 2003/2007 Application Integration 
Matrix 

The following chart should be used as a guide for expected behavior with Microsoft Office 2007 and 
Microsoft Office 2003 documents.  The chart shows the behaviors that are specific to the type of 
document, which is listed in the Type of Document column.  Some behaviors are also based on how 
the individual DM libraries are configured.  For libraries that are configured with Office 2007 file 
extensions, those behaviors are in the two columns under the Office 2007 Library column.  For 
libraries that are configured with Office 2003 file extensions, those behaviors are in the two columns 
under the Office 2003 Library column.  Further specification has been made for each library 
configuration depending on which client-side Office application is being used.  The integration was 
designed so that DM Extensions would work independent of what file format is being saved into 
DM, thus avoiding the need to keep all documents in the same file format per library.  Note that 
Microsoft requires the installation of their Office 2007 compatibility pack for Office 2003 clients to 
open, edit and save Office 2007 file formatted documents. 

 NOTE: There is a known Microsoft issue with PowerPoint. The following information describes 
the issue and is from Microsoft’s support site: 

“A presentation is unexpectedly saved as a .ppt file when you save a PowerPoint 2007 presenta-

tion (.pptx) file programmatically  

You run PowerPoint 2003 that has the Compatibility Pack for Microsoft Office 2007 File Formats in-

stalled, and you save the presentation by using the object model that uses ActivePresentation.Save. 

If you save a presentation as a .pptx file, the presentation is unexpectedly saved in the .ppt format. 

Additionally, the presentation is saved with both the .pptx and the .ppt file name extensions as in 

the following example:  

file name .pptx.ppt” 

To resolve this issue you must contact Microsoft to obtain the Post SP3 Patch as indicated by 
Microsoft’s knowledge base article KB936058. 
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Office 2007 Library 
(Default extension set to 
.docx) 

Office 2003 Library 
(Default extension set to 
.doc) 

Type of Document 

2003 Client 
Saves As 

2007 Client 
Saves As 

2003 Client 
Saves As 

2007 Client 
Saves As 

Design 
Explaine
d 

Saving a New Document to DM 2007 (.docx, 

.xlsx, .pptx) 
2007 (.docx, 

.xlsx, .pptx) 
2003 (.doc, 

.xls, .ppt) 
2003 (.doc, 

.xls, .ppt) 
See  6.1 

Saving a New Document Natively Defaults to 
application’s 
default save 
type 

Defaults to 
application’s 
default save 
type 

Defaults to 
application’s 
default save 
type 

Defaults to 
application’s 
default save 
type 

See  6.2 

Saving a New Document to DM 

that Was Previously Saved in 

Office 2007 File Format Natively 

2007(.docx, 

.xlsx, .pptx) 
2007(.docx, 

.xlsx, .pptx) 
2007(.docx, 

.xlsx, .pptx) 
2007(.docx, 

.xlsx, .pptx) 
See  6.3 

Saving a New Document to DM 

that Was Previously Saved in 

Office 2003 File Format Natively 

2003(.doc, 

.xls, .ppt) 
2003(.doc, 

.xls, .ppt) 
2003(.doc, 

.xls, .ppt) 
2003(.doc, 

.xls, .ppt) 
See  6.4 

Saving an Existing Office 2007 DM 

Document Back to DM 

2007(.docx, 

.xlsx, .pptx) 
2007(.docx, 

.xlsx, .pptx) 
2007(.docx, 

.xlsx, .pptx) 
2007(.docx, 

.xlsx, .pptx) 
See  6.5 

Saving an Existing Office 2003 DM 

Document Back to DM 

2003(.doc, 

.xls, .ppt) 
2003(.doc, 

.xls, .ppt) 
2003(.doc, 

.xls, .ppt) 
2003(.doc, 

.xls, .ppt) 

See  6.6 

Saving an Existing Office 2007 DM 

Document Natively 

2007(.docx, 

.xlsx, .pptx) 
2007(.docx, 

.xlsx, .pptx) 
2007(.docx, 

.xlsx, .pptx) 
2007(.docx, 

.xlsx, .pptx) 
See  6.7 

Saving an Existing Office 2003 DM 

Document Natively 

2003(.doc, 

.xls, .ppt) 
2003(.doc, 

.xls, .ppt) 
2003(.doc, 

.xls, .ppt) 
2003(.doc, 

.xls, .ppt) 

See  6.8 

Saving an Existing Office 2007 

Attachment from an  

E-mail Message 

2007(.docx, 

.xlsx, .pptx) 
2007(.docx, 

.xlsx, .pptx) 
2007(.docx, 

.xlsx, .pptx) 
2007(.docx, 

.xlsx, .pptx) 
See  6.9 
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Office 2007 Library 
(Default extension set to 
.docx) 

Office 2003 Library 
(Default extension set to 
.doc) 

Type of Document 

2003 Client 
Saves As 

2007 Client 
Saves As 

2003 Client 
Saves As 

2007 Client 
Saves As 

Design 
Explaine
d 

Saving an Existing Office 2003 

Attachment from an  

E-mail Message 

2003(.doc, 

.xls, .ppt) 
2003(.doc, 

.xls, .ppt) 
2003(.doc, 

.xls, .ppt) 
2003(.doc, 

.xls, .ppt) 
See  6.10 

Inserting an Existing DM Office 

2007 Document in an E-mail 

Message 

2007(.docx, 

.xlsx, .pptx) 
2007(.docx, 

.xlsx, .pptx) 
2007(.docx, 

.xlsx, .pptx) 
2007(.docx, 

.xlsx, .pptx) 
See  6.11 

Inserting an Existing DM Office 

2003 Document in an E-mail 

Message 

2003(.doc, 

.xls, .ppt) 
2003(.doc, 

.xls, .ppt) 
2003(.doc, 

.xls, .ppt) 
2003(.doc, 

.xls, .ppt) 
See  6.12 

Exporting an Existing Office 2007 

DM Document 

2007(.docx, 

.xlsx, .pptx) 
2007(.docx, 

.xlsx, .pptx) 
2007(.docx, 

.xlsx, .pptx) 
2007(.docx, 

.xlsx, .pptx) 
See  6.13 

Exporting an Existing Office 2003 

DM Document 

2003(.doc, 

.xls, .ppt) 
2003(.doc, 

.xls, .ppt) 
2003(.doc, 

.xls, .ppt) 
2003(.doc, 

.xls, .ppt) 

See  6.14 

Saving a Natively-Saved Office 

2007 Document to DM as a DM 

Version of an Office 2007 

Document 

2007(.docx, 

.xlsx, .pptx) 
2007(.docx, 

.xlsx, .pptx) 
2007(.docx, 

.xlsx, .pptx) 
2007(.docx, 

.xlsx, .pptx) 
See  6.15 

Saving a New Office 2007 

Document to DM as a DM Version 

of an Office 2003 Document 

Not 
supported 

Not 
supported 

Not 
supported 

Not 
supported 

See  6.16 

Saving a Natively-Saved Office 

2003 Document to DM as a DM 

Version of an Office 2003 

Document 

2003(.doc, 

.xls, .ppt) 
2003(.doc, 

.xls, .ppt) 
2003(.doc, 

.xls, .ppt) 
2003(.doc, 

.xls, .ppt) 

See  6.17 
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Office 2007 Library 
(Default extension set to 
.docx) 

Office 2003 Library 
(Default extension set to 
.doc) 

Type of Document 

2003 Client 
Saves As 

2007 Client 
Saves As 

2003 Client 
Saves As 

2007 Client 
Saves As 

Design 
Explaine
d 

Saving a New Office 2003 

Document to DM as a DM Version 

of an Office 2007 Document 

Not 
supported 

Not 
supported 

Not 
supported 

Not 
supported 

See  6.18 

Copying an Existing DM Office 

2003 Document to Attaché 

2003(.doc, 

.xls, .ppt) 
2003(.doc, 

.xls, .ppt) 
2003(.doc, 

.xls, .ppt) 
2003(.doc, 

.xls, .ppt) 
See  6.19 

Copying an Existing DM Office 

2007 Document to Attaché 

2007(.docx, 

.xlsx, .pptx) 
2007(.docx, 

.xlsx, .pptx) 
2007(.docx, 

.xlsx, .pptx) 
2007(.docx, 

.xlsx, .pptx) 

See  6.20 

Importing an Office 2003 Document 

from Attaché 

2003(.doc, 

.xls, .ppt) 
2003(.doc, 

.xls, .ppt) 
2003(.doc, 

.xls, .ppt) 
2003(.doc, 

.xls, .ppt) 
See  6.21 

Importing an Office 2007 Document 

from Attaché 

2007(.docx, 

.xlsx, .pptx) 
2007(.docx, 

.xlsx, .pptx) 
2007(.docx, 

.xlsx, .pptx) 
2007(.docx, 

.xlsx, .pptx) 

See  6.22 

Exporting or E-mailing a DRF to an 

Office 2003 DM Document 

2003(.doc, 

.xls, .ppt) 
2003(.doc, 

.xls, .ppt) 
2003(.doc, 

.xls, .ppt) 
2003(.doc, 

.xls, .ppt) 
See  6.23 

Exporting or E-mailing a DRF to an 

Office 2007 DM Document 

2007(.docx, 

.xlsx, .pptx) 
2007(.docx, 

.xlsx, .pptx) 
2007(.docx, 

.xlsx, .pptx) 
2007(.docx, 

.xlsx, .pptx) 

See  6.24 

Importing Office 2007 document 2007(.docx, 

.xlsx, .pptx) 
2007(.docx, 

.xlsx, .pptx) 
2007(.docx, 

.xlsx, .pptx) 
2007(.docx, 

.xlsx, .pptx) 
See 6.26 

Importing Office 2003 Document 2003(.doc, 

.xls, .ppt) 
2003(.doc, 

.xls, .ppt) 
2003(.doc, 

.xls, .ppt) 
2003(.doc, 

.xls, .ppt) 

See 6.26 
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6.1 Saving a New Document to DM 

When a new document is saved to DM through the authoring application, such as Word or Excel, 
DM will examine the library settings and save the file accordingly. For example, if your library is set 
up to use the Office 2007 file formats (such as .docx), when a user selects New Document inside of 
Microsoft Word, makes edits and then saves the changes, the document will save to DM as an Office 
2007 document.  The document is saved in this file format even when the client-side application is 
Office 2003 with the Microsoft compatibility pack. 

6.2 Saving a New Document Natively 

When a new document is saved natively through the authoring application, such as Word or Excel, 
DM will respect the default save type settings specific to that application.  These save defaults are set 
in each individual client workstation per application.  Access to this configuration can differ 
between applications. For example, this setting is located in Word 2003 in Tools>Options>Save 

tab>Save Word File as.   

For example, when you create a new document, make edits and select to save the document locally 
instead of to DM, if you have set up your Office 2007 client application to default to Office 2003 file 
formats (such as doc), by default the document will be saved in an Office 2003 (doc) file format. 

6.3 Saving a New Document to DM that Was 
Previously Saved in Office 2007 File Format Natively 

A document, which has already been saved outside of DM natively, will be saved to DM in its 
original file format.  DM does not consider library settings or client application. For example, if your 
library is set up to use the Office 2003 file formats (such as .doc and .xls) and you open a document 
from your desktop with Word 2003, if the document is in Office 2007 (.docx) file format, it will be 
saved to DM as an Office 2007 document (using the .docx file extension).  DM will not convert the 
document based on your library settings; this is to help avoid issues where file formatting specific to 
Office 2007 might be lost. 

6.4 Saving a New Document to DM that Was 
Previously Saved in Office 2003 File Format Natively 

A document, which has already been saved outside of DM natively, will be saved to DM in its 
original file format.  DM does not consider library settings or client application. For example, if your 
library is set up to use the Office 2007 file formats (such as .docx and .xlsx) and you open a 
document from your desktop with Word 2007, if the document is in Office 2003 (.doc) file format, it 
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will be saved to DM as an Office 2003 document (using the .doc file extension).  DM will not convert 
the document based on your library settings.  

6.5 Saving an Existing Office 2007 DM Document Back 
to DM 

A document, which has already been saved to DM, will be saved back to DM in its original file 
format, including saving the document as a new version or subversion.  DM does not consider 
library settings or client application. For example, if your library is set up to use the Office 2003 file 
formats (such as .doc) and you open a document from DM with Word 2007, if the document is in 
Office 2007 (.docx) file format, it will be saved to DM as an Office 2007 document (using the .docx 
file extension).  DM will not convert the document based on your library settings.  

NOTE: When you select the New Document option when saving an existing DM document, the 
file extension remain the same as the existing document. For example, if you open a Word 2007 
document (such as text.docx) and then save it as a new document to a library with the Office 2003 
file format, the extension will remain the same (such as newdoc.docx). The file is saved based on the 
library setting. 

6.6 Saving an Existing Office 2003 DM Document Back 
to DM 

A document, which has already been saved to DM, will be saved back to DM in its original file 
format, including saving the document as a new version or subversion. DM does not consider 
library settings or client application. For example, if your library is set up to use the Office 2007 file 
formats (such as .docx) and you open a document from DM with Word 2007, if the document is in 
Office 2003 (.doc) file format, it will be saved to DM as an Office 2003 document (using the .doc file 
extension).  DM will not convert the document based on your library settings. 

NOTE: When you select the New Document option when saving an existing DM document, the 
file extension remain the same as the existing document. For example, if you open a Word 2003 
document (such as text.doc) and then save it as a new document to a library with the Office 2007 file 
format, the extension will remain the same (such as newdoc.doc). The file is saved based on the 
library setting. 
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6.7 Saving an Existing Office 2007 DM Document 
Natively 

A document, which has already been saved to DM, will be saved natively (to your desktop, for 
example) in its original file format.  DM does not consider library settings or client application. For 
example, if your library is set up to use the Office 2003 file formats (such as .doc) and you open a 
document from DM with Word 2007, if the document is in Office 2007 (.doc) file format, it will be 
saved natively as an Office 2003 document (using the .doc file extension).  DM will not convert the 
document based on your library settings, nor will it default to your application’s default save type 
settings. 

NOTE: Due to a known issue with PowerPoint 2003, in order to save a PowerPoint 2007 
formatted file in Office 2007 format, you will need to select the .pptx extension from the Save as type 
drop-down list. 

6.8 Saving an Existing Office 2003 DM Document 
Natively 

A document, which has already been saved to DM, will be saved natively (to your desktop, for 
example), in its original file format.  DM does not consider library settings or client application. For 
example, if your library is set up to use the Office 2007 file formats (such as .docx) and you open a 
document from DM with Word 2007, if the document is in Office 2007 (.doc) file format, it will be 
saved natively as an Office 2007 document (using the .doc file extension).  DM will not convert the 
document based on your library settings, nor will it default to your application’s default save type 
settings.  

6.9 Saving an Existing Office 2007 Attachment from an  
E-mail Message 

A document, which is attached to an e-mail message, will be saved to DM in its original file format.  
DM does not consider library settings or client application. For example, if your library is set up to 
use the Office 2003 file formats (such as .doc) and you save an e-mail attachment to DM with 
Outlook 2007, if the attachment is in Office 2007 (.docx) file format, it will be saved to DM as an 
Office 2007 document (using the .docx file extension).  Because conversions of documents are done 
only within the authoring applications, such as Microsoft Word or Excel 2007, documents saved as 
attachments from e-mail messages cannot be converted through Outlook.   
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6.10 Saving an Existing Office 2003 Attachment from an  
E-mail Message 

A document, which is attached to an e-mail message, will be saved to DM in its original file format.  
DM does not consider library settings or client application. For example, if your library is set up to 
use the Office 2007 file formats (such as .docx) and you save an e-mail attachment to DM with 
Outlook 2007, if the attachment is in Office 2003 (.doc) file format, it will be saved to DM as an Office 
2003 document (using the .doc file extension).  Because conversions of documents are done only 
within the authoring applications, such as Microsoft Word or Excel 2007, documents saved as 
attachments from e-mail messages cannot be converted through Outlook.   

6.11 Inserting an Existing DM Office 2007 Document in 
an E-mail Message 

A document, which already exists in DM, will maintain its original file format when the document is 
inserted into an e-mail message.  DM does not consider library settings or client application. For 
example, if your library is set up to use the Office 2003 file formats (such as .doc) and you attach a 
document to an e-mail with Outlook 2007, if the attachment is in Office 2007 (.docx) file format, it 
will be inserted into the e-mail message as an Office 2007 document (using the .docx file extension).  
Because conversions of documents are done only within the authoring applications, such as 
Microsoft Word or Excel 2007, DM documents attached to e-mail messages cannot be converted 
through Outlook. 

6.12 Inserting an Existing DM Office 2003 Document in 
an E-mail Message 

A document, which already exists in DM, will maintain its original file format when the document is 
inserted into an e-mail message.  DM does not consider library settings or client application. For 
example, if your library is set up to use the Office 2007 file formats (such as .docx) and you attach a 
document to an e-mail message with Outlook 2003, if the attachment is in an Office 2003 (.doc) file 
format, it will be attached to the e-mail message as an Office 2003 document (using the .doc file 
extension).  Because conversions of documents are done only within the authoring applications, such 
as Microsoft Word or Excel 2007, DM documents attached to e-mail messages cannot be converted 
through Outlook. 

6.13 Exporting an Existing Office 2007 DM Document 

A document, which has already been saved to DM, will be exported in its original file format. DM 
does not consider library settings or client application. For example, if your library is set up to use 
the Office 2003 file formats (such as .doc) and you drag and drop a document from DM to your 
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desktop, if the document is in Office 2007 (.docx) file format, it will be saved to your desktop as an 
Office 2007 document (using the .docx file extension).  DM will not convert the document based on 
your library settings, nor will it default to your application’s default save type settings.  

6.14 Exporting an Existing Office 2003 DM Document 

A document, which has already been saved to DM, will be exported in its original file format.  DM 
does not consider library settings or client application. For example, if your library is set up to use 
the Office 2007 file formats (such as .docx) and you drag and drop a document from DM to your 
desktop, if the document is in Office 2003 (.doc) file format, it will be saved to your desktop as an 
Office 2003 document (using the .doc file extension).  DM will not convert the document based on 
your library settings, nor will it default to your application’s default save type settings.  

6.15 Saving a Natively-Saved Office 2007 Document to 
DM as a DM Version of an Office 2007 Document 

A document, which has already been saved outside of DM natively, will be saved to DM in its 
original file format, even when the user saves the document using the Save As DM Version option 
within the Office application.  DM does not consider library settings or client application. For 
example, if your library is set up to use the Office 2003 file formats (such as .doc) and you open a 
natively-saved document with Word 2003, if the document is in Office 2007 (.docx) file format, it will 
be saved to DM as an Office 2007 document (using the .docx file extension).  DM will not convert the 
document based on your library settings, nor will it convert the document based on the existing DM 
document.   

6.16 Saving a New Office 2007 Document to DM as a 
DM Version of an Office 2003 Document 

The ability to save documents where individual versions have different file types is not supported in 
DM 6.0.5, nor is it supported in any previous version. All document versions saved or imported to 
DM must have the same file extensions and file formatting as the original document. 

For example, if you create a Word 2007 document and select the Save As DM Version option and 
select a Word 2003 document, the new document is saved with the .doc file extension. 

6.17 Saving a Natively-Saved Office 2003 Document to 
DM as a DM Version of an Office 2003 Document 

A document, which has already been saved outside of DM natively, will be saved to DM in its 
original file format, even when the user saves the document using the Save As DM Version option 
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within the Office application.  DM does not consider library settings or client application. For 
example, if your library is set up to use the Office 2007 file formats (such as .docx) and you open a 
natively-saved document with Word 2007, if the document is in Office 2003 (.doc) file format, it will 
be saved to DM as an Office 2003 document (using the .doc file extension).  DM will not convert the 
document based on your library settings, nor will it convert the document based on the existing DM 
document’s file format.   

6.18 Saving a New Office 2003 Document to DM as a 
DM Version of an Office 2007 Document 

The ability to save documents where individual versions have different file types is not supported in 
DM 6.0.5, nor is it supported in any previous version. All document versions saved or imported to 
DM must have the same file extensions and file formatting as the original document. 

For example, if you create a Word 2003 document and select the Save As DM Version option and 
select a Word 2007 document, the new document is saved with the .docx file extension. 
 

6.19 Copying an Existing DM Office 2003 Document to 
Attaché 

A document, which has already been saved to DM, will be copied to Attaché in its original file 
format.  DM does not consider library settings or client application. For example, if your library is set 
up to use the Office 2007 file formats (such as .docx) and you drag and drop a document from DM to 
your Attaché folder, if the document is in Office 2003 (.doc) file format, it will be saved to Attaché as 
an Office 2003 document (using the .doc file extension).  DM will not convert the document based on 
your library settings. 

6.20 Copying an Existing DM Office 2007 Document to 
Attaché 

A document, which has already been saved to DM, will be copied to Attaché in its original file 
format.  DM does not consider library settings or client application. For example, if your library is set 
up to use the Office 2003 file formats (such as .doc) and you drag and drop a document from DM to 
your Attaché folder, if the document is in Office 2007 (.docx) file format, it will be saved to Attaché 
as an Office 2007 document (using the .docx file extension).  DM will not convert the document 
based on your library settings. 
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6.21 Importing an Office 2003 Document from Attaché 

A document, which has already been saved to your Attaché folder, will be copied to DM in its 
original file format.  DM does not consider library settings or client application. For example, if your 
library is set up to use the Office 2007 file formats (such as .docx) and you import a document from 
Attaché to DM, if the document is in Office 2003 (.doc) file format, it will be saved to DM as an Office 
2003 document (using the .doc file extension).  DM will not convert the document based on your 
library settings. 

NOTE:  When you attempt to import a document from Attaché as a version of the existing 
document, the document is imported correctly; however, the document’s file extension is changed to 
match the library settings. To avoid this issue, you should import documents as new documents. 
This information is available in DM-13963.  

6.22 Importing an Office 2007 Document from Attaché 

A document, which has already been saved to your Attaché folder, will be copied to DM in its 
original file format.  DM does not consider library settings or client application. For example, if your 
library is set up to use the Office 2003 file formats (such as .doc) and you import a document from 
Attaché to DM, if the document is in Office 2007 (.docx) file format, it will be saved to DM as an 
Office 2007 document (using the .docx file extension).  DM will not convert the document based on 
your library settings. 

NOTE:  When you attempt to import a document from Attaché as a version of the existing 
document, the document is imported correctly; however, the document’s file extension is changed to 
match the library settings. To avoid this issue, you should import documents as new documents. 
This information is available in DM-13963.  

6.23 Exporting or E-mailing a DRF to an Office 2003 DM 
Document 

A document, which has already been saved to DM, will maintain its original file format when it is 
exported or e-mailed as a DRF.  For example, if your library is set up to use the Office 2007 file 
formats (such as .docx) and you export or e-mail a DRF to an Office 2003 file formatted DM 
document, the document’s DRF will appropriately reference the document so that it can be opened 
as an Office 2003 file formatted document.  DM will not convert the document based on your library 
settings. 
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6.24 Exporting or E-mailing a DRF to an Office 2007 DM 
Document 

A document, which has already been saved to DM, will maintain its original file format when it is 
exported or e-mailed as a DRF.  For example, if your library is set up to use the Office 2003 file 
formats (such as .doc) and you export or e-mail a DRF to an Office 2007 file formatted DM 
document, the document’s DRF will appropriately reference the document so that it can be opened 
as an Office 2007 file formatted document.  DM will not convert the document based on your library 
settings.  

6.25 Importing an Existing Office 2007 Document 

A document, which has already been saved natively, will be exported in its original file format. DM 
does not consider library settings or client application. For example, if your library is set up to use 
the Office 2003 file formats (such as .doc) and you choose File � Import from DM Extensions, to if 
the document is in Office 2007 (.docx) file format, it will be saved into DM as an Office 2007 
document (using the .docx file extension).  DM will not convert the document based on your library 
settings, nor will it default to your application’s default save type settings.  

6.26 Importing an Existing Office 2003 Document 

A document, which has already been saved natively, will be exported in its original file format. DM 
does not consider library settings or client application. For example, if your library is set up to use 
the Office 2007 file formats (such as .docx) and you choose File � Import from DM Extensions, to if 
the document is in Office 2007 (.docx) file format, it will be saved into DM as an Office 2003 
document (using the .doc file extension).  DM will not convert the document based on your library 
settings, nor will it default to your application’s default save type settings.  
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Chapter 7  

Known Issues 

7.1 Outlook Issues 

DM-14274:  Viewing message using right click on the document name in "Save to Hummingbird 
DM" dialog is not working.  To view the document, double click the document name to launch the 
preview window. 

DM-14957: Outlook 2007 - "Document Mailing Options" dialog appears twice when dragging and 
dropping a document to a new mail message.  The email messages are saved appropriately. 

DM-12780: Outlook 2007 – Dragging and dropping email messages into DM when holding the 
control key down results in an error message.  To workaround this issue, use the left-click drag and 
drop to bring up the context menu for a “copy”. 

DM-14736, DM-14393 and DM-14647 – Outstanding issues based on changes we made to support 
Outlook 2007 and may present the following symptoms: the tree view may be displayed improperly 

and intermittently crash Outlook.  Research & Development is continuing to work on these issues 

and will be providing updates as soon as they become available. 

 

7.2 Interceptor Issues 

DM-14876: Interceptor for Acrobat Reader 8 - When opening a document into reader and then 
exiting, the document remains checked out.  To unlock the document, exit DM Extensions and log 
back in to DM Extensions. 

DM-13750: Use template document to create new document in Powerpoint2007 gives error. 
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7.3 Application Integration Issues 

DM-13527: DM Application Integration - Word - Quick Retrieve Dialog Box Appears When Editing 
a Native email Hyperlink.  You can edit the hyperlink by clicking Cancel in the Quick Retrieve. 

DM-14634: Visio 2007 sp1 Passive COM Integration - Save As and Save in DM menu and File menu 
are unavailable on specific templates.  of the Brainstorming Visio Templates produces the problem,  
although this issue is not necessarily limited to that template. 

DM-14839: Excel 2007 - Vista - Error when saving a native document created from the Windows 
desktop. When you create an Excel document from the Windows desktop by right-clicking the 
desktop and selecting New>Microsoft Excel Worksheet, and then you open the document to make 
edits and click Save, an error is received.  Despite the error, the edits are saved. 

DM-14643: Error message is displayed when user opens a Hyperlink from PowerPoint 2007. 

 

7.4 DM Extensions Issues 

DM-14527: Document(s) left in the Transient state, which don't give the typist full rights, cannot be 
deleted. 

DM-14532: When attempting to open a document from a Search Results window by choosing 
Document � View from the menu, the buttons, Open, Print and Copy are inactive.   

DM-14528: Executing the search options from the Search menu on a Quick Search in a workspace 
does not perform any actions.  This issue only occurs from the DM Extensions Search menu.  As a 
workaround, you can use the right-click context menu from the workspace to edit and delete Quick 
Searches. 

DM-14339: Lotus Notes Client Searches do not return results. An error "View or Navigator 
'Adhoc_Search_Results' does not exist" appears.  This issue only occurs on Windows Vista SP1 when 
searches are conducted from within Lotus Notes 7.x. 

DM-10807: Selecting E-mail Integration blocks the Client Deployment Utility application for 30+ 
seconds. 



Index 
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7.5 DM Webtop Issues 

DM-14725: The Date/Time field does not work correctly in DM Webtop when entering information 
in the Email_Sent field on the profile form. 

. 
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Chapter 8  

Files Delivered 

 

A list of affected files can be found here. 

 

 


